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About This Release

ABOUT THIS RELEASE
This document describes the enhancements for GeoMedia. Although the information in this document is current as
of the product release, see the Hexagon Geospatial Support website for the most current version.
This release includes both enhancements and fixes. For information on enhancements, see the New Technology
section. For information on fixes that were made to GeoMedia for this release, see the Issues Resolved section.
This document is only an overview and does not provide all of the details about the product's capabilities. See the
online help and other documents provided with GeoMedia for more information.
The scope of this document is the GeoMedia Desktop (GeoMedia Essentials, GeoMedia Advantage, GeoMedia
Professional) as well as GeoMedia Viewer and GeoMedia Objects.

GEOMEDIA PRODUCT TIERS
GeoMedia® is a flexible and dynamic GIS package for creating, updating, managing and analyzing your valuable
geospatial information. Generate and update vector layers. Perform dynamic spatial analysis and generate reports.
Automatically create and update maps. Manage data and map production more efficiently. GeoMedia is available
in three product tiers, Essentials, Advantage, and Professional.
GeoMedia Essentials enables you to query and analyse a wide variety of geospatial data sources. It also includes
ERDAS IMAGINE Essentials, giving you the ability to do simple image preparation.
GeoMedia Advantage has all the functionality of GeoMedia Essentials and is excellent for data collection and
editing, processing and analyzing elevation and terrain data including LiDAR. It also includes data validation and
sophisticated raster analysis tools.
GeoMedia Professional includes all of the features of the previous tiers and provides enterprise-wide, multi-user
data management and analysis. Manage linear networks, produce professional cartographic maps, conduct
advanced feature editing, manage parcel holdings, conduct utility network analysis, monitor and control changes,
integrate data from multiple sources, and assure overall data quality with GeoMedia Professional.

NEW PLATFORMS
DATABASES
DATABASE UTILITIES
The utility Database Utilities now supports Oracle 12.2 through use of the Oracle OLEDB provider.
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Impacts

IMPACTS
COMPATIBILITY
ERDAS IMAGINE INSTALLATION ORDER
If ERDAS IMAGINE 16.1 or earlier is installed after GeoMedia Desktop 16.1, the GeoMedia installation is
compromised and will not run properly. To correct or avoid the issue, choose your situation, and follow one of
these instructions.


Install ERDAS IMAGINE first and then GeoMedia 16.1.



If you already installed GeoMedia 16.1 and then installed ERDAS IMAGINEx, run the GeoMedia setup
again, this time selecting the “Modify, repair, or remove” option. When prompted, select “Repair”.

EXPRESSIONS
HANDLING OF NULL VALUES IN THE NOT BETWEEN OPERATOR
In the functional attribute system and when querying a feature cache, the NOT BETWEEN operator has been fixed
to properly handle the NULL value case. Specifically, when BETWEEN evaluates to NULL, NOT BETWEEN also
now evaluates to NULL rather than TRUE, so that “A NOT BETWEEN B AND C” now returns the same answer as
“NOT(A BETWEEN B AND C)”. This may impact query results for the Functional Attribute, Analytical Merge, and
Aggregation commands; as well as attribute-based map displays and map tooltip definitions that involve
expressions.

BOOLEAN EXPRESSIONS WITH ATTRIBUTE-BASED SYMBOLOGY
When an expression is evaluated in the context of the map display system (e.g. in an attribute-based definition for
a style property), and that expression yields a Boolean data type with a NULL value, then that NULL value is now
returned as expected. This is important because some Boolean style properties (e.g. Displayable) are defined as
“if missing, then true”. If the expression were to return a value of FALSE rather than NULL, then a NULL value
cannot be received by the style property.
However when such an expression is evaluated in any other context (e.g. in the computation of a functional
attribute), then the NULL value is converted to FALSE in order to simulate previous behaviour and minimize
impact.
Techniques that may be used for accommodating the new 16.0 behavior include:


Use the ISNULL(value, valueIfNull) function. This returns “value” if it is not NULL, and “valueIfNull” if it is
NULL.



Use the “value IS NULL” operator to test whether “value” is or is not NULL. This operator returns only
TRUE or FALSE.

This change was introduced with GeoMedia Desktop 16.0 but was not documented until now.
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Future Impacts

FUTURE IMPACTS
None.

NEW TECHNOLOGY
GENERAL
INVOKECOMMAND METHOD
Invoke the Select Tool command through API
The method InvokeCommand on the Application object now supports invocation of the Select Tool command.

FEATURE CACHING
LOGGING
More easily diagnose behaviour of the feature caching system
An optional log file may be created, and if present the feature caching system will provide diagnostic information
about whether and how caches are being used at runtime.

IMPROVED PERFORMANCE
Get even faster performance from your feature cache
IFC files that are created with GeoMedia Desktop 16.1 are organized for even better performance, especially for
cases of very large files accessed over a network share. Previously published feature cache files remain
compatible, but performance will improve if the files are newly published.

COMPATIBILITY WITH ADVANCED FEATURE MODEL
Combine cache-based high performance with advanced feature modeling
On the New Warehouse Connection command as well as the Properties dialog of the Warehouse Connections
command, the “Enable advanced feature model” and “Enable feature caching” checkboxes are no longer mutually
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exclusive. The performance improvements that come with feature caching are now available for AFM-configured
warehouses as well.

DATA ACCESS
POSTGIS DATA SERVER
Experience improvements to the PostGIS data server
The PostGIS data server now better supports multi-table read-write views of various kinds, and supports queries
against the picklist table.
The PostGIS data server now filters out feature classes which have table and field names containing uppercase
characters. Such characters require special syntax in SQL and are not supported within GeoMedia.
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WMS DATA SERVER
More easily connect to certain WMS sites
The WMS data server now automatically recognizes and handles certain Coordinate Reference Systems as being
defined with swapped axes (e.g. Y-X rather than X-Y). It is no longer necessary to add a .ini file entry to convey
the need to swap axes, in most such cases. The .ini file entry is still available for cases in which the software
misinterprets the CRS, or in which the WMS site results don’t match the CRS.

WMTS DATA SERVER
More easily connect to certain WMTS sites
The WMTS data server now automatically recognizes and handles certain Coordinate Reference Systems as
being defined with swapped axes (e.g. Y-X rather than X-Y). In addition, an .ini file entry is now available for cases
in which the software misinterprets the CRS, or in which the WMTS site results don’t match the CRS.

ADVANCED FEATURE MODEL
AFMCONVERTSERVICE
Convert your non-AFM warehouse to being AFM-ready via API
AFMConvertService is a new component that provides the ability through API to convert a standard non-AFM
warehouse to a warehouse configured for the Advanced Feature Model. This capability was previously available
only through GUI.

COMPATIBILITY WITH FEATURE CACHING
Combine cache-based high performance with advanced feature modeling
On the New Warehouse Connection command as well as the Properties dialog of the Warehouse Connections
command, the “Enable advanced feature model” and “Enable feature caching” checkboxes are no longer mutually
exclusive. The performance improvements that come with feature caching are now available for AFM-configured
warehouses as well.

ANALYSIS
SPATIAL INTERSECTION COMMAND AND SPATIALINTERSECTIONPIPE
Perpetuate key definitions from input features to output features
SpatialIntersectionPipe and the Spatial Intersection command that uses it, now transmit the individual key
definitions of the incoming recordsets into the output query as a composite key.

DATA OUTPUT
OUTPUTTOTABLESERVICE
Disable transactions when writing features to a read-write warehouse
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OutputToTableService now provides a .DisableTransactions property which, when set to True, causes the object
to avoid all BeginTrans, CommitTrans, and Rollback operations. Control of transactions is left completely to the
calling application.

SPATIAL MODELING
RUN SPATIAL MODEL COMMAND
Run spatial models within the GeoMedia desktop
This new command integrates spatial models into GeoMedia. It allows the user to select a model (.gmdx file)
created through the Spatial Model Editor utility; fill in any parameters in the model dynamically, especially features
input to the model from the GeoWorkspace; and then see the various results from the model added to the map
within the GeoWorkspace.
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EXPLORER WINDOW
Manage spatial models within the GeoMedia environment
A new “Spatial Models” entry in the Explorer window lets you easily see what spatial models have been run within
the GeoWorkspace, and to manage them by rerunning them, changing their names and other properties, and
deleting them. You can also see the various results of the run, and display them in a map or data window.

SUPPORT FOR SPATIAL MODEL RESULTS IN COMMANDS
Directly select spatial model results as input to various GeoMedia commands
Many commands in GeoMedia which present features for selection through a feature treeview control, now support
the selection of spatial model results in addition to feature classes, queries, categories, and the like. In such
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cases, a new “Spatial Models” branch appears in the tree, with each spatial model in the GeoWorkspace visible
beneath it. Expand a model and then select the various results for processing.

Commands which support selection of spatial model results include: Add Legend Entries, Add Thematic Legend
Entry, New Data Window, Change Data Window Contents, Output to Feature Classes, Attribute Query, Attribute
Selection, Join, Union, Spatial Query, Spatial Intersection, Spatial Difference, Buffer Zone, Analytical Merge,
Aggregation, and Functional Attributes.
To use spatial model results within commands that do not yet support them directly, output the results to a feature
class via Output to Feature Classes, or build a query on the results via Attribute Query that passes through all of
the features.

SAMPLE SPATIAL MODELS
Reference sample models to learn how to build your own
The default spatial models folder (C:\GeoWorkspaces\SpatialModels) now contains sample models that
demonstrate use of certain operators and demonstrate how to construct a model properly for use with the Run
Spatial Model command.
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System Requirements

SPATIAL MODEL EDITOR
Take advantage of the latest version of Spatial Model Editor
This utility has been upgraded to the latest version released with ERDAS IMAGINE 16.1.

UTILITIES
DATABASE UTILITIES
Experience improvements to PostGIS data server support
We’ve improved the PostGIS capabilities within Database Utilities, as well as changed the definition of the
GFeatures view to filter out feature classes which have table and field names containing uppercase characters.
Such characters require special syntax in SQL and are not supported within GeoMedia.

SYSTEM REQUIREMENTS


32-bit: 2GHz microprocessor, Intel® Pentium® 4 HT, Core™ Duo, Xeon



64-bit: Intel 64 (EM64T), AMD 64, or equivalent (recommended)



4 GB minimum, 8 GB recommended



10 GB for software



Data storage requirements vary by mapping project1

Computer/ Processor

Memory (RAM)

Disk Space

Software security (Intergraph Licensing 11.11.1) requires the following:
Peripherals


Ethernet card



Windows® 7 SP1 or higher, Professional and Ultimate (32-bit and 64-bit)2



Windows® 8 (Standard), Professional and Enterprise (32-bit and 64-bit)2



Windows® 8.1 (Standard), Professional and Enterprise (32-bit and 64-bit)2



Windows® 10.0 (Standard), Professional and Enterprise (32-bit and 64-bit)2



Windows Server® 2008 R2 SP1 (64-bit)3



Windows Server 2012 R2 (64-bit)3



VMware ESX 5.1



Oracle VM Virtual Box



XenApp 7.6

Operating Systems2

Virtual Server and Virtual
App Technology
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Database Server Engines

Database Client Engines



Remote App (MS 2012 R2)



Oracle® Server 11g, 32-bit and 64-bit, at least version 11.2.0.3



Oracle Express 11g, at least version 11.2.0.3



Oracle® Server 12.1, 64-bit



SQL Server® 2012, 64-bit



SQL Server Express 2012



SQL Server 2014, 64-bit



SQL Server 2014 Express



PostgreSQL 9.3 with PostGIS 2.1



PostgreSQL 9.4 with PostGIS 2.2



Oracle Client 11g, 32-bit4



Oracle Client 12.1, 32-bit4



SQL Server Native Client 10.0 or higher5

SYSTEM REQUIREMENTS NOTES
1

Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity.
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves
performance. Disk arrays improve productivity but some RAID options slow performance. Network disk drives are
subject to network limitations.
2

Windows 7 32-bit, Windows 8 32-bit, Windows 8.1 32-bit and Windows 10 32-bit are considered viable platforms.
Viable platforms are not an explicit requirement and have not been tested as a standard scenario in Hexagon
Geospatial’s Development and Quality Assurance cycles. However, the technology is similar to one of the
supported platforms that compatibility is practical. Although we expect our applications to be compatible with viable
platforms, we cannot guarantee contractual performance or high availability requirements.
3

GeoMedia runs on 64-bit systems in 32-bit emulation mode.

4

Oracle Data Access Components (ODAC) is required if using the Feature Accessor option for Oracle in the
PublishIFC utility, or if using the Database Utilities utility to manage an Oracle warehouse. ODAC is normally
delivered by the Oracle Client Administrator installer, but not by the Oracle InstantClient installer. ODAC contains
many components, of which PublishIFC requires the Oracle Data Provider for .NET, and Database Utilities
requires the Oracle Provider for OLEDB.
5

The SQL Server Native Client 10.0 or higher is needed in order for the Database Utilities utility to automatically
create the correct GeoMedia metadata for date, time, and datetime2 data types when using a SQL Server or SQL
Server Spatial warehouse. You may get SQL Server Native Client 10.0 or higher from the corresponding Microsoft
websites. If the SQL Server Native Client is not installed on the system, you will need to manually choose Date as
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the data type from the dropdown combo box for these data types in the Feature Class Properties dialog and set
the format properly.

ISSUES RESOLVED
CR #

Summary

Description / How to Reproduce

Intersection does not work with
offset temporary construction lines.

Using offset when digitizing with the Intersection snap enabled does not work with the
construction lines displayed for the offset.
Steps to reproduce.

86726_GM

1-LJ3K3P

1.

Open the IntersectionSnap.gws and correct the path to the City.mdb.

2.

Insert a county_street feature using an offset of 500 and select mutiple
creek features to display the construction lines.

3.

Start digitizing and select an intersection of the construction lines and see
how the Intersection snap glyph does not appear or work.

Error in GWM
CreateLegendEntryGraphic due to
an issue in the Oracle Dataserver.

With further investigation of WebMap Issue, CR 1-LFPXCQ, by Development, it has
been determined that the problem in WebMap is caused by an issue in the Oracle
Dataserver.

GeoMedia application may hang
when using Properties on Windows
8.1 or Windows 10.

The properties control may hang GeoMedia on certain operating systems. It has
been observed that on Windows 8.1 and Windows 10, that when interacting with
other applications, if the user clicks on the Cancel option on the Properties dialog
then the application may hang. Specifically, the application hangs if the control does
not have focus (top highlighted in blue) when the Cancel option is selected.
Workflow (Windows 10):
1.

Start the GeoMedia application, with features displayed in map window
(USSampledata.gws for example).

2.

Start a secondary application such as Process Monitor.

3.

In GeoMedia Map Window, double-click graphic feature to invoke
Properties dialog.

4.

Click on the secondary application to make it active (leaving Properties
dialog open in GM).

5.

Click the Close option on the Properties control (without giving focus to
control).

1-LI3G2M

1-QNNZK5

For GM Map Publisher, the queued
edit Map Window is not displaying
Generalize Results correctly.

GeoMedia Desktop 16.00.0000.01405 and GeoMedia Map Publisher
16.00.0000.00012
There is an issue with the displayed results appearing in the Queued Edit Map
Window, specifically:
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CAD data server fails to serve
TextPointGeometry for AutoCAD
TAGs (block attributes).

1-QRXT3F

1.

The original geometry is not displaying in the Queued Edit Map Window.

2.

The CDRGeometry (conflict reference geometry) is not displayed in the
Queued Edit Map Window.

3.

The conflict geometry and original geometry are not appearing as dashes.

A SR was filed asking for assistance in serving the Text geometry that is associated
with TAGS from an AutoCAD Block (as is displayed in AutoCAD itself). However
based on testing thus far this doesn’t appear to be possible despite the fact that the
‘AutoCAD Scanner Design Specification’ document indicates that the TAG type
should be mapped to TextPointGeometry.
Specifically the Native-to-GDO Geometry Type Mapping table in the ‘AutoCAD
Scanner Design Specification’ document shows the Native Geometry Type of ‘TAG’
(described as “Attributes that are attached to block entities in the drawing file.”)
mapped to the GDO Geometry Type of ‘TextPointGeometry’. However attempts to
serve the TAG attributes from the customer provided dwg file as text results in 0
geometries for the TextGeometry legend entry.

Copy Parallel > Snap to point
doesn't place line on point.

Copy Parallel > Snap to point doesn't place line on point.
Try to copy an Interstate through a city out of USSample Data set.

1-JP60JI

1.

Start Copy Parallel

2.

Identify Interstate for Copy Parallel

3.

Snap on City point to copy parallel

The snap won't be accepted. The Interstate is not copied parallel through the
citypoint, instead it is copied in the vicinity.

1-MJA88J

OpenRecordset with
gdbOpenSnapshot and spatial filter
results in an empty recordset for
PostGIS GDO.

Opening a recordset with a combination of gdbOpenSnapshot type and any valid
spatial filter results in an empty recordset being returned. Attached is a sample .NET
application demonstrating the issue.

Select set problems when join
displayed.

When a Join is displayed, the user may notice incorrect select set display in the map
window while interacting with corresponding data view. The problem seems to be
display only but can be confusing. It does not occur in version 6.1 but is latent to
2014.
For example, the user might have the following entries on the legend:

1-D0B8O8
•

States

•

Join of States and Counties

The user may select the record for Arizona in a States data table, but both Arizona
and Utah will be selected in the map view.
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Shared cache appears to be slower
than Exclusive cache due to query
parsing.

Customer has created Oracle trace files that they believe indicates that the Net
(Shared) caching is slower than Local (Exclusive) caching due to parsing of query
statments for indexes, views, and tables. The trace files created by the customer are
included in the attached zip file and TKPROF file. The problem description provided
by the region as taken from the SR is shown below.
We have received a TKPROF file (GM_startup_prod.tkp) from the customer made for
the startup of a workspace (which looks directly in Oracle view), where they note that
a lot of time is spent on parsing statements that query for indexes for the various
views and tables.

1-L7FF1D

It accounts for a significant amount of the total startup time. If you look at the
summary for non-recursive statement at the bottom of the TKPROF file you can see
that almost 24 seconds are spent parsing.
Would it be possible to reduce time spent parsing by using bind variables?

Reverse Direction does not work on
a secondary geometry, it reverses
the unselected primary geometry.

Secondary geometries are not reversed when using the Reverse Direction command
from the Vector tab or when using the Reverse command from the Geometry
Information context menu. Here is the workflow to reproduce the problem:
1.

Extract the attached ReverseGeometry.zip file and then open the
ReverseGeometry.gws that has an Access connection to the
ReverseGeometry.mdb file.
a.

1-QJA89D

1-LRSMRH

Ghost circles rendered in display
when create thematic of polygons
containing arcs (Regression).

When the .gws is opened, note that the legend contains two
entries for the feature class named LineFeature and its
associated secondary geometry named ‘Geometry2 of
LineFeature’. The primary geometry for the feature class is
displayed in red and the secondary geometry in blue.
Additionally a style is applied with an arrow symbol indicating the
direction of each geometry.

2.

Use the cursor to click on one of the secondary geometries in the map
window (i.e. the red geometry). Note that only the secondary geometry is
shown in the select color (e.g. green highlight).

3.

Now choose the Reverse Direction command from Vector > Edit on the
ribbon bar. This will result in the reversal of the primary geometry even
though it was not selected, while the secondary geometry which was
selected remains unchanged. This is apparent because the arrows for the
blue primary geometry style are reversed, but the arrows for the red
secondary geometry are still pointing in the original direction.

2.

4. This same behavior is observed with the Reverse command when
accessed via Geometry Information. For instance select the red secondary
geometry, then choose the Geometry Information command and right click
on the ‘PolylineGeometry’ node, then choose Reverse from the displayed
context menu. As before, the primary geometry will be reversed, but the
selected secondary geometry will remain “as is”.

Creation of a thematic mapping with color fill of polygon geometries containing small
arc geometry components may result in color filled circles appearing in both map and
layout window displays; the circles change in distribution and size depending on
zoom scale. The problem is not seen in version 2015.
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See attachments for screen shot showing comparison between version 2015 and
2016. If the arcs are removed from the polygon geometries, the problem does not
occur in version 2016.
Workflow using data provided in Attachments:
1.

Extract contents of .zip

2.

Use GeoMedia 2016 to open Version2016_Access.gws, correcting path to
source warehouse.

3.

Observe small circles in the map display that change with changes in the
display scale.

If review Geometry Information for some of the polygons, you can see that the
geometry has arc components; The geometry seems to pass standard Toolbox >
Validate Geometry checks (no problems are found).
If the arcs are removed the problem does not occur.

Unable to display (.ecw) WMTS
layers that can be displayed
successfully in other applications.

Unable to display (.ecw) layers from ERDAS Apollo WMTS service that can be
displayed successfully in other applications.
The GeoMedia WMTS data server is unable to display certain layers from the ERDAS
Apollo Essentials WMTS service. The same layers can be displayed successfully in
other clients using the same coordinate system (either EPSG:4326 or EPSG:3857).
The layers from the service that fail to display in GeoMedia (but display in the other
clients) are ‘sandiego3i_ecw’ and ‘bucuresti_ecw’.
To reproduce the problem, use the steps below.
1.

Start GeoMedia and make a new WMTS connection.:

2.

Use Add Legend Entries to add ‘sandiego3i_ecw’ to the legend. A legend
entry will be created with geometry statistics showing one instance.

3.

If you fit the view and click the map window you can see the layer footprint
highlighted, but there is no image/tiles displayed within the footprint.

1-M17EFA

The coordinate system used in all of the clients was the same (EPSG:4326).
* Note that the ‘sandiego3i_jp2’ and ‘‘sandiego3i_otdf’ layers from the same service
can be displayed successfully in GeoMedia . These layers appear to be the same as
the ‘sandiego3i_ecw’ with presumably a different format for the source imagery (i.e.
JPEG 2000 and OTDF respectively). This means that the problem appears to be
specific the ECW format.

WMTS data server
requests/displays data in wrong
coordinate system (other clients
work correctly).

The GeoMedia WMTS data server serves the ‘MAPA TOPOGRAFICZNA’ feature
class from the WMTS service with the wrong coordinate system. Specifically the
GetTile requests uses the EPSG:4326 TileMatrixSet instead of the default
EPSG:2180 TileMatrixSet.

1-M8DCID
The EPSG:2180 TileMatrixSet appears to be the default since it is the first listed in
the GetCapabilities document and GeoMedia will even show that the coordinate
system assigned to the ‘MAPA TOPOGRAFICZNA’ feature class is EPSG:2180 after
it is served using the WMTS data server.
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There appears to be a disconnect between the metadata in that Feature Class
Definition indicates that the coordinate system is EPSG:2180 and the actual feature
class served which seems to be EPSG:4326. This problem results in an incomplete
display of ‘MAPA TOPOGRAFICZNA’ feature class in the Map Window and the
portion of the data that is visible is warped presumably due to the coordinate system
transformation from EPSG:4326 to EPSG:2180.
The same problem exists even if you use a Warehouse Configuration File (.ini) for the
WMTS connection with the following entry defining the default TileMatrixSet as
EPSG:2180.
[TileMatrixSet for Feature Classes]
Default=EPSG:2180

Layout > Print/Plot > Background
image prints black (Images with
more than 3 bands).

Customer has 6" resolution imagery. These are uncompressed 4 band (32bit) untiled
TIFF (tested with and without overviews) for their service area. They report that the
images appear solid black when trying to output a layout to .pdf or other printing
device.
Data attached. Open provided GWS, connect to USSampleData or a blank Access
connection. Insert the two Geotiffs. Print to PDF (Used PDF995 locally) and outputs
are black for the images. Also tested with Adobe Acrobat 10 and the local hard copy
devices.

1-ANAB3S

Workaround is to give the image feature class (or any feature class displayed on
legend) a 1% translucency. The image plots, looks great.
This is not specific to TIFF images, seen with JFIF and other formats as well.
Development informs me that this is a problem common to all 4-sample-per-pixel
data.

1-M2V06J

Errors occur with multiple
commands when using PostGIS
table names containing upper case
characters.

The PostGIS data server in GeoMedia 2016 does not correctly handle feature
class/table names that contain uppercase letters, resulting in errors. This issue was
reported by a customer who states that the open source PostGIS data server that
could be used with GeoMedia 2015 did not have this problem.

Layout - Text Placement and Text
Properties > Support for OpenType
(.otf) fonts is missing.

There is a failure when displaying OpenType fonts in GeoMedia 2013. Support
replicated failure on both GeoMedia 6.2 and Geomedia 2014.
In versions of GeoMedia prior to 6.1 (5.2, 6.0), this .otf font was available in the drop
down list for text placement in the Layout Window, and the text was displayed with
the proper font. But starting in the 6.1 version, the fonts does not show up in the drop
down list - they are not available for placing new text in the layout window.

1-95FGMS

In versions since 5.2 (5.2, 6.0, 6.1, 2013, 2014) right click on selected layout text and
then 'Properties' shows the text properties dialog. In the sample .gws provided, note
that the customer's font is the StencilStd.otf, and that it displays with bright green
color, indicating a non-supported font.. Also note that newly placed text in a new,
blank .gws can also be given the StencilStd.otf font, but that the layout window does
not display the text with this font properly - text apears bright green.
Thus there are two parts to this CR-D. One is a regression from 6.0 GeoMedia to
later versions – you can no longer place or display layout text with .otf fonts. The
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second part is that if the regression was an intentional change in the product, one
should not be able to select .otf font from the layout Text Properties dialog.
Poth parts are resolved if we restore the previous functionality, placement and display
of layout text with OpenType fonts.

Originating Pipe recordset
open/reopen spams registry for
GDO configuration.

Opening a recordset through an originating pipe will cause it to check the registry for
CacheEnabled setting for the specific connection type. However, this is accomplished
by instantiating a whole new GDOServerRegEntries object that enumerates the whole
HKLM\Software\Wow6432Node\GDO registry subkey and parses values therein.
The function using the GDOServerRegEntries is:
GMConnection::GetCacheFileName, which it does even if the given connection is
created without explicitly enabling caching.

1-SMHSUB

This causes a registry contention in an environment when multiple concurrent GDO
requests are being served, like in a WebMap installation.

Using WMTS data server hangs
GeoMedia forcing the GeoMedia
process to be killed with Task
Manager.

Use of the WMTS data server results in GeoMedia hanging (where there is no
response to any mouse click), thus forcing the GeoMedia process to be killed via
Task Manager. This hang is sometimes preceded by what is presumably a Microsoft
Windows dialog with the title 'Server Busy' and the message "This action cannot be
completed because the other program is busy. Choose 'Switch To' activate the busy
program and correct the problem." On my Windows 7 machine if I click the ’Switch
To’ button the Start Menu is displayed and it appears that the GeoMedia application is
still the active program. I was unable to reproduce a case where the ‘Server Busy’
error occurs consistently, although the issue has been observed with multiple WMTS
services. However I did find a simple workflow that appears to consistently result in
GeoMedia hanging. This problem seems to occur most often when using the Zoom
In command or the Pan command while WMTS layers are displayed in the Map
Window while already zoomed into the data set. Here are the steps to reproduce the
problem.
1.

1-LUTZ6G

Open the provided ‘WMTS_Kademo2.gws’ which has a single WMTS
connection to the service used.
There are six layers present in this WMTS and all of the layers are added to
the legend and displayed in the Map Window. The Display Scale for the
Map Window is set to 1:2500.

2.

Select the ‘Zoom In’ command and at the prompt “Click to zoom or press
and drag”, place a single data point in the center of Map Window to perform
a zoom.
After the data point is placed, the Map Window display starts to update and
the ‘Processing window update…’ message is displayed in the message
strip. However, the update of the display never completes and the wait
cursor remains displayed indefinitely. If you click the ESC key to cancel the
update the wait cursor will disappear and the ‘Processing window update…’
message will be removed, but GeoMedia is now in a completely
unresponsive state, so the only recourse is to kill the GeoMedia process.

* To reproduce this issue a second time you may need to remove the temp files from
your user temp folder (i.e. %TEMP%).

1-LTZTTN

Some WMTS services are not
displayed.

The WMTS servvices of our customer published by ERDAS APOLLO Ess+SDI are
not dispalyed correctly in the GM. The capabilities document is loaded, but no other
picture ("data") is loaded into the map winddow. Only blank frame is displayed in the
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GM. It should use EPSG:5514. The capabilities document containes czech diacritic
letters and more tilematrixset.

Update Attributes - geometry
functions fail to update.

Any functional expression that updates geometry fails with errors.
Example workflow: Attempting to use Update Attributes to compress a geometry fails
in version 2016.
Using a standard COMPRESS(Input.Geometry) to update an area geometry field in
2016 fails with the following message:
--------------------------GeoMedia Desktop
Update Attributes was unable to update all features. Please refer to log file
C:\Warehouses\\States.txt for details.
--------------------------Review of the text file shows the following error for each record processed:

1-LR7ZLA

“could not be updated. Data type conversion error”
Workflow:
1.

Open USSampleData.gws

2.

Vector > Update > Update Attributes

3.

Select States, click in Geometry field and select Expression.

4.

Build expression for COMPRESS(Input.Geometry) then add the
expression.

5.

Click OK to run the update.

Observe the error messages.

1-SD94Q1

1-TEDR0Q

GeometryStorageService fails to
transform PolygonGeometry when
run inprocess from .NET.

A working sample of PolygonGeometry construction and transforming to storage blob
by the means of GeometryStorageService usage was working up to the newest 15.0
release of GeoMedia. When the same application is recompiled in a 16.0 environment
it fails when all the objects (PolygonGeometry, point and GeometryStorageService)
are created inprocess of a .NET application. It does not fail when run from inside a
native COM process like the MapSvr.exe of GeoMedia WebMap.

Attribute Based Style not correctly
evaluated/displayed in GeoMedia
2016.

A customer has a data set that makes extensive use of Attribute Based Styles that
displays correctly (i.e. as expected based on the ABS expressions) in GeoMedia
2015, but when the same .gws is opened in GeoMedia 2016 the styles rendered are
incorrect. In other words the styles do not appear the same in GeoMedia 2016 as
they do in GeoMedia 2015.
One of the issues involves the use of a nested IF expression to assign Color or
Override Color based on the values of One (or Two) attributes.
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Attribute Based Style is incorrectly
displayed in GeoMedia 2016.

A customer that uses ABS extensively filed a SR stating that the display of the styles
in their GeoWorkspace was significantly different when the .gws was opened in
GeoMedia 2016 as compared to the same .gws in GeoMedia 2015. Upon
investigation there appear to be multiple issues with the evaluation of Attribute Based
expressions This CR is filed for an issue with the expressions used by the customer
on the CharacterString property as a means to specify which of several available Font
Styles from a Point Style Collection should be displayed for a particular feature
instance.

Functional nested IF statement
returns incorrect results when
evaluating null values.

User-provided functional expression that works to return valid values for all records in
2015, fails to return valid values for some records in 2016.

1-THBCC0

1-LRSQEP

The user is using a nested IF statement.

1-SLIP4P

Memory leak apparent in the
PostGIS GDO.

There seems to be a memory leak caused by the PostGISRW.GDatabase object
while opening consecutive recordsets from the same connection. This is apparent in
the WebMap workflows during stress testing.

GeoMedia / Webmap memory error
in GML dataserver.

There is a memory problem in GeoMedia Pro / WebMap Pro when using GML
dataserver. We do have a production system based on GeoMedia / Webmap 2014
with latest patch (14EP08). However the same problem was identified in GMPro15
and GMPro16 during our tests.
Workflow in GMPro:
1. Open GMPro. The GeoMedia application process memory usage is ~ 50.MB.
2. Create new warehouse connection –using a GML type The GeoMedia application
process memory usage is ~ 250.MB
3. Add EGB_PktGraniczny_copy feature class to the map window. The GeoMedia
application process memory usage is ~ 265.MB

1-SBLPA3
4. Remove legend entries from the legend.
5. Close and delete the GML connection.
GeoMedia application process memory usage remains the same ~ 250.MB.
When using Webmap on our Customers production system we do have a lot of big
GMLs that need to be imported to continuous Oracle database. We suffer
OutOfMemory exceptions and HResult exceptions because of this error described
above.
To compare, do the same workflow with Access warehouse type using
USSampleData. You will notice that the memory is being released after closing and
deleting connection.

1-L4T7SQ

Features from spatially filtered GML
connection fail to display when
GeoWorkspace is re-opened.

When a GeoWorkspace with a connection to the customer provided GML file has a
spatial filter applied, the features from GML connection will be filtered as expected
and the legend statistics will be displayed appropriately. However if that
GeoWorkspace is then saved with the spatial filter in place and then reopened the
features from the GML connection that were filtered will be missing from the Map
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Window and the legend statistics will show a value of ‘0’ for the corresponding legend
entries.

1-S0AO0B

GeoMedia performance problem:
Oracle LTT 12c fails to use bind
variables for select from
all_indexes.

User testing of GeoMedia version 2015, has noted a potential performance issue
while working with Oracle 12c using GeoMedia Oracle LTT data server. It has been
proposed that the performance is due to GeoMedia’s failure to use bind variables
when the GeoMedia Oracle LTT data server issues queries such as SELECT FROM
ALL_INDEXES.

Event AfterUpdate(vbCanceled,
objGFeature) - objGFeature is not
initialized after first insert.

This code in VB .NET (AfterUpdate Event):
Private Sub Fnc_AfterUpdate(ByVal vbCanceled As Boolean, ByVal objFeature As
PAFM.GFeature) Handles currentFeatureClassEvent.AfterUpdateHandler
Try
MsgBox("State: " + objFeature.State.ToString())
Catch ex As Exception
MsgBox(ex.Message)
End Try

1-CAJXWS

End Sub
Return exception after insert first feature in GM2015:
Feature must by initialized with either Bookmark or KeyAttributeValues
Notes - GM 2015:
objFeature is not filled with right attributes of new added Feature, witch exist in this
moment in DB
next insert of the same feature is OK
Note: GM2013 - 14: there is error too, but calling objFeature.State in if-then statement
in AfterUpdate event filled objFeature with right attributes

After upgrade to GeoMedia 2016
cannot open a number of Geomedia
2014 created GeoWorkspaces.

1-QR3T93

A customer filed a SR reporting that several of their GeoWorkspaces that were
created with GeoMedia 2014 cannot be opened successfully in GeoMedia 2016 (i.e. a
‘Failed to open document’ message is displayed when an attempt is made to open
the .gws in 2016.)
The customer provided a sample GeoWorkspace that exhibits this problem named
‘StandardMapsBase_Mary.gws’. I was able to confirm that the
‘StandardMapsBase_Mary.gws’ can be opened successfully using GeoMedia
14.00.0002.00098, but when the same .gws is opened in GeoMedia 16.00.0000.1405
a ‘Failed to open document’ message is displayed. When attempting to open the
.gws in GeoMedia 2016 a number of the map windows are loaded prior to the ‘Failed
to open document’ message, but as soon as the message dialog is dismissed with
the OK button the .gws is closed.
This behavior is somewhat different than typical ‘Failed to open document’ situation
(since the .gws did appear to try to load the map windows). So this led to the
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conclusion that there might be one or more objects in one of the eleven different map
windows that was causing the error.
After some investigation I discovered that the issue appears to be caused by one
specific legend entry. Specifically a unique value thematic entry named 'Route Shield
County Scale' in the Map Window named 'ESZs'. If the 'Route Shield County Scale'
legend entry from this map window is deleted from the .gws while it is open in
GeoMedia 2014 and then the .gws is saved without that legend entry, the .gws can
then be opened successfully in GeoMedia 2016. An example of the .gws with the
legend entry removed (that will open in 2016) is included in the Attachments tab with
the name ‘StandardMapsBase_No_RouteShieldCountyScale.gws’.

Desktop 2015 GeoWorkspace
cannot be opened on Desktop
2016.

Customer reports, support duplicates a problem where a .gws created with vanilla
GMDesktop 2015 cannot be opened in vanilla GMDesktop 2016. Workflow to
reproduce:


Copy attachment 'Tom.gwt' to GMDesktop 2015 templates folder
"C:\Program Files (x86)\Hexagon\GeoMedia
Professional\Templates\GeoWorkspaces". Start GMDesktop, new .gws,
select 'tom.gwt' as the template. At this point I made an Access connection
to USSampleData.mdb and added a few legend entries. Exit and save the
.gws.



On a GMDesktop 2016 system, open the saved .gws. Error appears.



Attachment 'joe_15.gws' was created using this workflow and will not open
on my GMDesktop 2016 system.

1-T4DNWD

Creating a new .gws on 2016 using this same template doesn't cause a problem.

1-S3NVRQ

2016 G/Tech Interface features not
loading Style Index. Regression
from G/Tech Interface 2015.

Using GeoMedia 2016 the StyleIndex for some Features imported with the
G/Techinterface are not generated. This results in the displayed Style in the Map to
be incorrect. GeoMedia 2015 generates the StyleIndex.

New GeoWorkSpaces NOT saved
after selecting yes to save.

Users who use GeoWorkSpace template (.gwt) files other than Normal.gwt may
encounter problems saving GeoWorkSpaces upon exiting.
Example workflow using supplied GeoWorkSpace template (.gwt) file:

1-SDCP7C

1.

Create new GeoWorkSpace using the template option.

2.

Use a template other than Normal.gwt (see attachments for examle).

3.

Optionally do queries etc in the GeoWorkSpace.

4.

Select File > Exit, select Yes to save.

Observation: The Save GeoWorkSpace As dialog does NOT appear. GeoMedia
simply exits and none of the work performed in step 3 is saved. The GeoWorkSpace
does not seem to be saved anywhere.

1-F5HZ7Q

GeoMedia Professional 2015 does
not honor long-press gesture for
"right-click" on touch screen.

GeoMedia Professional 2015 does not respond to typical "right-click" replacement on
tablet touch screen devices (long press). This worked previously, in GeoMedia 6.1.
We are unable to "right click" using the touch screen functionality on our tablet. "rightclick" is typically replaced by a long press and hold on touch/tablet devices using a
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long press. GeoMedia responds to double-tap (double-click) and single tap (singleclick), but does not react to the right-click/long press action.
This makes it impossible to copy/paste text into attribute fields, as well as toggle layer
visibility within the application. All tests indicate that the issue is not one with
hardware (this function works elsewhere on the device).

Right click doesn't work on
touchscreen under Windows 8.

Customer has a laptop with touchscreen and Windows 8. Unfortunately the right click
doesn't work with GeoMedia. Works fine with the Windows itself but not with GM.
Is there some OS or application setting that controls this?
Customer was able to run GeoMedia on a Win8 machine with this result:

1-7ZHFQL

1)

When using a mouse, right-click in GeoMedia works fine.

2)

When using touch screen, right-click in GeoMedia is not working.

Right-click using touch screen in Windows itself (not GeoMedia), is:
•
press the fingertip and hold for a while - first I see a little circle around the
place where I touch, then for a little while it changes into a square and then a dialog
appears as expected
When customer tries the same in GeoMedia, they only get the circle around the place
where they touch, but no square, nor any dialog.
Tested this in GeoMedia 13.00.0000.00242.
The machine region used was Dell Latitude ST2.

Animated styles not updating/shown
with map extent change.

Animated styles not updating/shown with map extent change.
To reproduce:
-New GeoWorkspace with USSampleData access connection
-Add HighwayInterchange feature class
-Zoom in so that roughly 1/4 of the features are visible in the map

1-U5NDKZ
-Edit the style for HighwayInterchange so that it is animated. Changing the size
between 2 frames is sufficient. Animate upon display with unlimited repetitions.
-After applying the style, note that the features in the map display are animated.
-Zoom out, pan, etc. and note that none of the features outside the initial map extent
are displayed until the style is applied again.
Regression in 16.0 from 15.0. Initially discovered in 16.1..10195 using Oracle RW.

1-SD9H98

Selecting Attribute Properties dialog
crashes GM on German vm
w/German language package.

Selecting Attribute Properties dialog crashes or hangs GM on German vm w/German
language package.
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This hang/crash occurs on German WINDOWS 8 or WINDOWS 12 with the GM
German language package installed. The crash happens if GM is configured as
English also.
1. Open USExample.gws
2. Double click on State feature to bring up the Select Set Properties dialog.
3. Don't close the Select Set Properties Dialog
4. Click on Windows Start and GM geoworkspace hangs/crashes.

Attribute Properties dialog as well
as other dialogs fall behind other
applications.

User has noted that dialogs upgrade from VB6 do not pop to the top when the
GeoMedia application is selected. This can give users the illusion that the application
has hung and/or forces users to collapse all applications in effort to "search" for the
hidden GeoMedia dialog.
Problem occurs in both 2015 and 2016 but does not occur in 2014 for Attribute
Properties.
Example Workflow:

1-LR3GAX

1.

Open USSampledata.gws

2.

Double-click on graphic feature.

3.

The Properties dialog will appear showing attributes for the feature.

4.

Drag the dialog outside of the GeoWorkSpace document container.

5.

Activate some other application(s) such as MS Word or note pad, placing
the appliction over the Attribute Properties dialog. Obseve the dialog is
hiddent (this is expected).

6.

Now click inside of GeoMedia document giving focus to the GeoMedia
application. Notice that GeoMedia is NOT responsive until you search, find
and dismiss the hidden properties dialog.

Problem also noted for other dialogs such as Map Window Properties.
The user may be able to click on the application in the task bar or possibly use <Alt>
<Tab> keys to force dialog and application back to the top.

Release Guide missing
configuration dependencies for
certain utilities.

The GeoMedia Desktop Release Guide fails to include configuration dependancies
for the following:
Database Utilities requires that MS SQL Native Client 10.0 or higher be installed
when working with MS SQL Spatial warehouses. The MS SQL Native Client is
normally delivered as part of MS SQL Management Studio or can be installed as a
standalone product.

1-LRSQUG

Oracle Data Access Components (ODAC) is required if using the Feature Accessor
option in PulishIFC Utility. ODAC is normally delivered by Oracle Client Administrative
install but not for Oracle Instant Client.

1-AFI8VA

Tooltips in the map window only
display while using the select

When turning on tooltips for legend entries, they only display when the select tool is
selected. All other commands cause the pointer to change (from an arrow to whatever

25

Issues Resolved

command (clarify in
documentation).

glyph the command uses) and disables the tooltip display. This causes issues while
trying to figure out what event you’re looking at on the map while using a command
such as Interactive Calibration or Move.

Steps to reproduce

Grant Statements need to be
modified to be correct.



Open a GeoWorkspace and display a feature in the map window



Turn on map window tooltips for that feature. Ensure that the select tool is
selected and hover over a feature in the map window to verify that it is
displayed.



Switch to a command which changes the glyph (e.g. from the ribbon,
Vector > Move). You’ll notice that the glyph is changed to a crosshair.



Hover over a feature and notice that the tooltip does not display.

GRANT SELECT ON SYS.GV_$SESSION TO SYSTEM WITH GRANT OPTION;
should be modified to the following:
GRANT SELECT ON SYS.GV_$SESSION TO PUBLIC WITH GRANT OPTION;

1-VUIMMI

GRANT INHERIT PRIVILEGES ON SYSTEM TO GDOSYS:
should be modified to the following 2 lines:
GRANT SELECT ON SYS.V_$SESSION TO PUBLIC WITH GRANT OPTION;
GRANT SELECT ANY SEQUENCE TO WMSYS; -- allows use of identity based primary
keys in version enabled tables - new in Oracle 12c

1-LJFRUY

WMTS: Support sites with swapped
coordinate systems, via the INI
setting.

WMTS implementation does not currently support the case of a CRS with swapped
coordinates. The INI entry is present (as with WMS) but there is no implementation
present.

ECW images that displayed
properly in GM2015 have their
display corrupted.

Customer supplies several ECW images that do not display properly. Images display
as basically a black and grey block, and you must zoom way in to see the rough
outline of a feature. This problem relates to both the CS of the geoworkspace and
the size of the image. When in Geographic LL, the image displays fine. It also
displays fine in the Albers custom CS from USSampleData.gws. Image displays
incorrectly in customer's standard NAD83 for S. Louisiana (EPSG3452) To recreate:

1-LQ38PC






1-QKE51A

PostGIS GDO ModificationLog is
not properly updated after insert /
edit in join view.

Open GeoMedia Desktop,
Create a new .gws and create a new warehouse.
Insert one or both of the customer's .ecw files. The files display fine, since
the default CS for a new .gws/.mdb is Geographic.
Load the customer's NAD83 Louisiana SP CS and the image display is
corrupted.

If you have a join view defined with an INSTEAD of trigger/function in place, the GDO
ModificationLog table is not properly updated for inserts, edits and deleting. It may be
that there is some mistake but GeoMedia offers no example steps for an INSTEAD of
trigger workflow; The trigger works outside of GeoMedia.
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1-R2G9D9

Raster performance degredation
with GM 2015 versus earlier
versions.
Help Document > Batch Plotting >
Variable Text String Substitution:
Help is unclear

1-WHKTNF

Insert Feature fails with cannot
insert record if have database
Default Value defined (Regression)

The document says this:
-----------------------------Variable text strings are placed in the Layout template as standard fields by using a
unique syntax to identify it as a variable text string. There is no distinction made
between uppercase and lowercase. Variable text strings within fields are supported
when embedded within a sentence, as well as when appearing stand-alone as
“words”. When the layout sheet is composed, the text boxes in the layout sheet will be
evaluated. When a variable text string is encountered, the variable will be replaced
with the appropriate information obtained from the system, from the Base map plot
shape feature class (warehouse), or from the GeoWorkspace. All original text
symbology and formatting will be maintained. Variable text strings are only supported
when placed on the Working Sheet in the Layout template.
-----------------------------The two relevant sentences are "When the layout sheet is composed" and "Variable
text strings are only supported when placed on the Working Sheet in the Layout
template." Both indicate that the intent is that this works with Sheet Composition.
The Help document should explicitly state that VTSS is only available via Sheet
Composition.
User has MS SQL Spatial warehouse where one or more fields have default values
defined in the database using the Default Value or Binding property in the design view
of the table (MS SQL Management Studio). These default values are properly
populated by Insert Feature command in 2015 but Insert Feature in 2016 fails with an
error:
"Could not insert a record in the database."
Example:
User has defined default values using functions such as:
(getdate()) : returns the current date for a date field.
(suser_sname()) : returns the MS SQL user name inserting the record for a text field.

1-UR4591

GeoMedia hangs using Geometry
Information on Windows 8.1 or 10 if
focus changes to another app

1-VSDFXJ

User reports and support duplicates a serious performance degradation when
displaying raster feature classes in GMDesktop 2015, compared to GMPro 6.1 and
GM Desktop 2013 - 2014. Images that formerly took about 20 seconds to display
now take almost 8 minutes.
The Help for Batch Plotting does not explicitly state that Variable Text String
Substitution is only available via the Sheet Composition workflow. Customer
attempted to use the Sheet Selection workflow with a .gws containing [GM-Date] and
[GM-Time] in a template used w/ a layout sheet and filed an SR when this failed to
work properly.

These functions work when using Insert Feature in 2015 but fail in 2016. Records
CAN however be inserted into the data grid of the Data Window in 2016 thus the
problem may be related to the Properties control. Additionally records can be
inserted with proper default values when using Interactive Insert Area by Face. Insert
Area by Face however fails to properly populate default values (see Related CR 1UQW9FL).
A SR was filed reporting that when running GeoMedia Desktop 2015 on Windows 8.1
or Windows 10 the ‘Geometry Information’ dialog falls behind the GeoMedia map
window if focus switches to another application while the ‘Geometry Information’
dialog is displayed. This results in a hang of GeoMedia that requires the
GeoMedia.exe process to be killed via Task Manager. This appears to be essentially
the same behavior observed with the Select Set Properties dialog per CR 1-LI3G2M.
The customer that reported the issue with the Geometry Information command was
using Geomedia 2015 with the German Language pack configured. I have been able
to reproduce the problem with version 16.00.0000.01405 using the German
Language Pack configured as German or as English. The steps to reproduce the
issue are shown below.
1. On a Windows 8.1 or Windows 10 machine use Geomedia to open
USSampleData.gws.
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Documentation typo - Oracle
NUMBER(1,0) maps to BOOLEAN.

2. Click on a States feature class in the Map Window to select it and then right-click
and choose the ‘Geometry Information’ command from the menu.
3. Now that the ‘Geometry Information’ dialog is displayed, switch to another
application (the SR recommended the PDF Reader application which is what I used).
If using the PDF Reader application you can collapse the application window using
the minimize button (-) in the upper right corner.
4. Now that the GeoMedia application is visible again, note that the Geometry
Information dialog is no longer visible (it has presumably been hidden behind the map
window).
5. At this point you will be unable to perform any further actions in GeoMedia, thus the
GeoMedia process will have to be killed via Task Manager.
In the documentation (Using Oracle Connections-> Datatype matching - Oracle to
GeoMedia ) we have:
-----------------------------------------------------Oracle Datatype | GeoMedia Data Type
NUMBER (p,s) | Long (p<10,s=0)
----------------------------------------------------When creating table like

1-CF3XHZ

CREATE TABLE N ( GM_BOOL NUMBER(1,0) );
GM_BOOL is mapped to GeoMedia Boolean.
Should be:

Documentation > Help > Feature
Caching

1-KXGPVS

Changes to Help concerning use of
Hypertext fields

-----------------------------------------------------Oracle Datatype | GeoMedia Data Type
NUMBER (p,s) | Long (p<10>1, s=0)
----------------------------------------------------In GM Desktop Help file the first clause says :
"Feature Caching:
Geospatial applications deal with large volumes of data. This is true for all kinds of
geospatial data, from raster files and point clouds to file-resident and databaseresident geospatial features composed of geometry and attributes........"
While it is true that large volumes of data (raster, point clouds, etc.) are used in
GeoMedia, the relevance of this to Feature Caching I don't know. The document is
very misleading, causing customers to ask why their rasters are not being cached.
Users can right-click in data window or properties dialog to insert a file/path into a
field defined as Hypertext. While this can be useful for stored files, it does NOT allow
users to actually edit or define URL values.
Users can however, press and hold the <Ctrl> key when clicking into a Hypertext field
to edit a URL. This information should be added to GeoMedia Help in the section
titled: "Using Hypertext"
https://hexagongeospatial.fluidtopics.net/book#!book;uri=d697ac1e302b4bce1d79722
e4e4261b0;breadcrumb=42352cc5c9c8eb9183e92459d8d2d1bc42bbad5c1dbcf7a6719ce3c921e51cf9-86ec0c053a399ce0812c5d102253088ae0291cc5f0e76acf6962e905c6e9aa1a

1-LWVZPB

Suggest adding wording such as:
In Windows, single-clicking on a hyperlink activates the link rather than inserting the
cursor. To insert a cursor into hyperlink text you must Ctrl-Click. GeoMedia follows
this convention both in the Data View and in the attribute Properties control.

1-SCRY2U

Properties-Window of a feature
disappears when using an attributehyperlink. Only way to make windo

Suggest removing the section concerning the definition of Hypertext for MGE data
server.
Properties-Window of a feature disappears when using an attribute-hyperlink. After
klicking on the hyperlink, the window disapperars in the back (as shown in the
screenshots). Only way to make window visible again is via task-manager or crash
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GeoMedia. I found no "normal" way to make the window visible again in the
foreground.
We had this behaviour with more than 3 customers on the new version GM 2016
(Build 1405) and also with our partner-licences in our office.
A "simple" GM-customer has to crash the software to make it work again - we're off
the opinion that this should be fixed quickly.
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ABOUT US
Hexagon Geospatial helps you make sense of the dynamically changing world. We enable you to envision,
experience and communicate geographic information. Our technology provides you the form to design, develop
and deliver solutions that solve complex, real-world challenges. Ultimately, this is realized through our creative
software products and platforms.
CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including local, state and
national mapping agencies, transportation departments, defense organizations, engineering and utility companies,
and businesses serving agriculture and natural resource needs. Our portfolio enables these organizations to
holistically understand change and make clear, reliable decisions.
TECHNOLOGY. Our priority is to deliver products, platforms and solutions that make our customers successful.
Hexagon Geospatial is focused on developing technology that displays and interprets information in a
personalized, meaningful way. We enable you to transform location-based content into dynamic and useable
business information that creatively conveys the answers you need.
PARTNERS. As an organization, we are partner-focused, working alongside our channel to ensure we succeed
together. We provide the right platforms, products, and support to our business partners so that they may
successfully deliver sophisticated solutions for their customers. We recognize that we greatly extend our reach and
influence by cultivating channel partner relationships both inside and outside of Hexagon.
TEAM. As an employer, we recognize that the success of our business is the result of our highly motivated and
collaborative staff. At Hexagon Geospatial, we celebrate a diverse set of people and talents, and we respect
people for who they are and the wealth of knowledge they bring to the table. We retain talent by fostering individual
development and ensuring frequent opportunities to learn and grow.
HEXAGON. Hexagon’s solutions integrate sensors, software, domain knowledge and customer workflows into
intelligent information ecosystems that deliver actionable information. They are used in a broad range of vital
industries.
Hexagon (Nasdaq Stockholm: HEXA B) has more than 16,000 employees in 46 countries and net sales of
approximately 3.4bn USD. Learn more at hexagon.com and follow us @HexagonAB.
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ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, OR NON-INFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be error-free, that defects
will be corrected, or that any Hexagon Geospatial Website or the services that make Materials available are free of viruses or other harmful
components.
Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon Geospatial may make changes to this
Document at any time without notice.
Limitation Of Liability
IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL
DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA OR USE, INCURRED BY YOU OR ANY THIRD PARTY, WHETHER
IN AN ACTION IN CONTRACT OR TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS DOCUMENT.
Indemnification
You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, and agents from and against any
and all claims, liabilities, damages, losses or expense, including reasonable attorneys' fees and costs, arising out of or in any way connected
with your access to or use of this Document.
Use Of Software
Use of software described in this Document is subject to the terms of the end user license agreement that accompanies the software, if any.
You may not download or install any software that is accompanied by or includes an end user license agreement unless you have read and
accepted the terms of such license agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph or its licensors.
Portions of the user interface copyright 2012-20nn Telerik AD.
Links To Third-Party Websites
This Document may provide links to third-party websites for your convenience and information. Third-party websites will be governed by their
own terms and conditions. Hexagon Geospatial does not endorse companies or products to which it links.
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Third-party websites are owned and operated by independent parties over which Hexagon Geospatial has no control. Hexagon Geospatial shall
not have any liability resulting from your use of the third party website. Any link you make to or from the third party website will be at your own
risk and any information you share with the third party website will be subject to the terms of the third party website, including those relating to
confidentiality, data privacy, and security.
Trademarks
The trademarks, logos and service marks ("Marks") displayed in this Document are the property of Hexagon Geospatial, Intergraph or other
third parties. Users are not permitted to use Marks without the prior written consent of Hexagon Geospatial, Intergraph or the third party that
owns the Mark. "Intergraph" is a registered trademark of Intergraph Corporation in the United States and in other countries. Other brands and
product names are trademarks of their respective owners.
Find additional trademark information.
Procedure For Making Claims Of Copyright Infringement
Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following address: Intergraph Corporation,
Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama 35824.
US Government Restricted Right
Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S. Government is subject to
restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or successor provisions thereto. Use of Materials by the
Government constitutes acknowledgment of Hexagon Geospatial or Intergraph’s proprietary rights therein.
International Use
You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial makes no representation that
Materials are appropriate or available for use in every country, and access to them from territories where their content is illegal is prohibited.
Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain references or cross references to
Hexagon Geospatial products, programs and services that are not announced in your country. These references do not imply that Hexagon
Geospatial intends to announce such products, programs or services in your country.
The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree to comply strictly with all such
laws and regulations. In addition, you represent and warrant that you are not a national of, or otherwise located within, a country subject to U.S.
economic sanctions (including without limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not otherwise prohibited from
receiving or accessing the Materials under U.S. export control and economic sanctions laws and regulations. Hexagon Geospatial makes no
representation that the Materials are appropriate or available for use in every country, and access to them from territories where their content is
illegal is prohibited. All rights to use the Materials are granted on condition that such rights are forfeited if you fail to comply with the terms of
this agreement.
Revisions
Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly reviewing these Terms. Your
continued use of this Document after the effective date of such changes constitutes your acceptance of and agreement to such changes.
Applicable Law
This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of the State of Alabama will govern
these Terms, without giving effect to any principles of conflicts of law. You hereby irrevocably and unconditionally consent to submit to the
exclusive jurisdiction of the United States District Court for the Northern District of Alabama, Northeastern Division, or the Circuit Court for
Madison County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to commence any litigation relating
thereto except in such courts), waive any objection to the laying of venue of any such litigation in such Courts and agree not to plead or claim in
any such Courts that such litigation brought therein has been brought in an inconvenient forum. Some jurisdictions do not allow the exclusions
or limitations set forth in these Terms. Such exclusions or limitations shall apply in all jurisdictions to the maximum extent allowed by applicable
law.
Questions
Contact us with any questions regarding these Terms.
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